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Ron’s Ramblings 
I  have really and truly arranged a speaker for our meeting on Wednesday 5th 

May.  
David Stallard will talk to us about Digital Photography. Those of us who have 
been privileged enough to have heard David speak to meetings at our other 
venues know just how knowledgeable he is on this subject. 
 
ERRATA: 
In the last edition I gave the proposed date of the Computer Show as 
Saturday 21st August. The correct date I have been informed by Judy is 
Saturday the 7th August.  Mea Culpa, Mea Culpa, Mea Maxima Culpa. 
 
(I put the last bit of Latin in to prove I used to go to Mass) 
 
See if you can find the other Latin Word in this edition. 
 
I was not able to be present at the last meeting due to circumstances beyond my 
control. Also the speaker I hoped to line up was unable to appear that night. 
 
Look forward to the September Meeting (Our AGM) when Paul French from 
Tasmanian Printer Cartridge Company, Fresh from a Trade Fair and a Refillers 
Seminar will bring us the latest in Cartridge Technology 
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OPEN Session Times 
All sessions are held at the venue at  

Studioworks, 1 Pipeworks Rd, L’ton 
Standard Sessions  (All sessions $4.00) 

TAFE eLearn Sessions    
(All sessions $4.00) Started 15 March 2004 – All classes now full 

Special May Sessions 

Launceston Computer Group 
SOFTWARE LIBRARY 

Dated 1st May 2004 
 

DISK 1000 - Your Library on Disk 
Have you received your copy of Disk 1000? The disk holds a complete 
listing of programs available in our PC shareware library.  This disk is 
free of charge to all new members. 
DISK COPY PRICES - CLUB MEMBERS $1.00 per disk 
 
Disk Prices - Box of 25 =  $12.00 Members Only 
CD Prices – Box of 10  = $10.00  Members Only 

Judy Hall ,Shareware Librarian   

 
AVAILABILITY OF LIBRARY 

The Shareware Library is available in-between meetings from 
the following people. Please telephone first to arrange a 
suitable time.  
The library is also available at the venue - Studioworks 
most Wednesdays 9am to 3pm. Email:  
opencomputingtas@hotmail.com 
LAUNCESTON 
Julie Hjort    Phone 6344 5686 
Flat 2,  115 Penquite Road,  Newstead   Email:    jhjort@intas.net.
au 
 
    

Monthly Workshops 
Graphics – 19th May  

Next class 
PSP7 - Editing Photographs 

Wednesday  19th May 
1pm – 3.30pm 

$6.50 fee - Numbers limited to 8 please register on 
noticeboard or call Judy 63947358 or 0428 947358. 

---------------------------------------------- 
 
 

 

Family History Online 
Next Classes 

Wednesday 12th May 1pm–3.30pm & 
Tuesday 26th May  9pm – 12pm 

$4.00 fee     Numbers limited to 8 people 
Please register on noticeboard 

----------------------------------------------- 
Microsoft Publisher 
Next Class 
Thursday 5th May - 3pm to 5pm 
Please register on noticeboard – Fee $4.00 
Class sizes limited. 
----------------------------------------------- 
Windows & MS Word 

Keyboard Shortcuts 
Speeding up your work with keyboard shortcuts 

Wednesday 26th May - 1pm to 3pm 
Please register on noticeboard  

Fee $5.00 Includes printed handout. 
----------------------------------------------- 
OPEN  & Tutors Meeting 

 Wednesday 5th May. 
After lunch at the venue for our OPEN meeting and a 

special meeting of all tutors at OPEN to discuss classes 
and answer any questions our new tutors may have. 
Please Note: Visual Labels & SuperMail Session 

moved to 23rd June 
----------------------------------------------- 

VENUE TELEPHONE NUMBER 
A Mobile Phone Number is now available to all those 
wishing to contact OPEN during working hours.  The 
number is  

0413 698 610 

Monday 9am – 12 Beginners 
Monday 1pm – 3pm 2nd Step 
Tuesday 9am – 12 PC & Mac 
Tuesday 1pm – 3pm Beginners 
Wednesday 9am –12 Beginners 
Wednesday 2pm – 4pm 2nd Step 
Thursday 1pm - 3pm PC & Mac 

Monday 9am - 12 eLearn 

Thursday 9am – 12   eLearn 

Thursday 1pm - 3pm eLearn 

Friday 9am - 12 eLearn 

Wednesday   
 5th May 

1pm on OPEN  Meeting & Tutor 
Tutorial 

Wednesday  
 5th May 

7pm on LCG Monthly Meeting 

Thursday      
 6th May 

3 – 5 MS Publisher 

Wednesday  
 12th May 

1 – 3 Family History 

Wednesday  
 19th  May 

1 – 3 Graphics 

Tuesday       
 25th May 

9–12 Family History 

Wednesday  
 26th May 

1 -- 3 Win & MS Word 
Keyboard Shortcuts 

OPEN NEWSLETTER – MAY 2004 
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What’s Happening at OPEN 
 

OPEN Monthly Meetings  
SPECIAL LUNCHEON for TUTORS 
Open Meeting  5th May 2004 at 12.30  
This month we have a special luncheon booked at the 
All Year Round Hotel to start at 12.30 for the 
presentation of volunteer certificates and afterwards 
back at the venue for our regular meeting and a tutors 
meeting. 
------------------------------------------------------ 
Bulk Buy Booklets 
The books have now been ordered.   
------------------------------------------------------- 
Printing Costs 
With the purchase of the new printer we now have 
photographic quality printing available to all students. 
At this time the cost of printing will remain the same but 
may be reviewed in the future.  
 Current costs are:                                            
Photocopying                                       20c per page 
Printing to Kyocera Printer                   20c per page 
Printing black & white text to Canon    20c per page 
Printing text and graphics to Canon    40c per page 
Printing cards or full page graphics     $1.00 per page 
--------------------------------------------------------- 
Fee Alteration - $2 sessions 
Anyone attending a second class within the same week 
can now pay $4.00 for the first session and $2 for each 
subsequent session.  
Please Note: Special fee excludes sessions where 
special fees apply ie Graphics. 
----------------------------------------------------------- 
Huge welcome back to Fran Cox Great to have 
you back Fran, you were missed. 
 
 

MS Publisher Class 
This class has been moved to Thursday after the eLearn 
class, from 3pm to 5pm. 
--------------------------------------------------------- 
 

Special Monthly Meetings 
 

Launceston Computer Group Inc. 
1st Wednesday of the month 

Wednesday  5th May 2004 
Evening  7.30pm – 10pm 

 
----------------------------------------------------- 

Shareware 
Supermail  
Supermail is a handy little program, which is a companion to 
Visual Labels. It allows you to create a database of names, 
addresses and phone numbers and easily print them to 
envelopes or labels.  The information can be filtered easily to 
print only the desired records and setting up the labels uses 
the same interface as Visual Labels.  This program is 
shareware. 
 
Disk# >>> 3575 <<<Category>>>UT for WIN/W98<<< 
Supermail v2.2h 32bit 
SuperMail for Windows, v2.2h -  32-bit version for Windows 
95/98. This mailing list program allows you to maintain an 
unlimited number of records.  It prints labels, envelopes, 
letters, and reports. Complete set of mailing list management 
tools, including duplicate checker.Maintain an unlimited 
number of name/address records.  ·Maintain an unlimited 
number of separate mailing lists.  ·Print on all standard Avery 
mailing labels.  ·Print on any size envelope, including return 
address.  ·Create form letters & merge your names/addresses 
into letters ·Print hard copy reports.   
 

 
Free Copy of Newsletter 
Don’t forget to submit your email address if you wish to 
receive the LCG/OPEN newsletter via email.  If you 
have not yet received the newsletter via email tell your 
tutor. 
-------------------------------------------------------- 
Cleaning of the Venue 
We have finally secured a cleaner who will tackle the 
job of cleaning the rest room and the main computer 
room twice a month. 
Hooray. 
--------------------------------------------------------- 
eLearn Students 
eLearn has now started.  All those who are registered 
are asked to attend classes regularly and only attend 
on the day you are registered.  
If you need to attend a different class please speak to 
your tutor who can arrange this for you. 
------------------------------------------------------------ 
Welcome our new Tutors 
We are very pleased to report that we now have three 
new tutors helping with the eLearn classes.  They are 
Letty Rugari, Robert Tierney and Warren Ramsay.  
Welcome all and know that your help will be greatly 
appreciated. 
--------------------------------------------------------- 
Northern Tas. Camera Club 
Will now be meeting at the OPEN Rooms once a 
month with the first meeting set for Saturday April 24th.  
If you are interesed in Photoshop this may be of 
interest to you. 

OPEN NEWSLETTER – MAY 2004 
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Bypassing XP's Logon Screen 
 
Hi Fred: I am running Windows XP Professional and when I 
restart my windows instead of going into windows so you can 
start working you have to hit your user name to continue 
loading. As I am the only person who uses my computer I would 
like that option back again and also every so often when I 
don't move the mouse it goes back to that screen like a 
screensaver I cant find anywhere to disarm this at all either. 
do you have a solution to mostly the start problem when you 
have to click that user name please when all said and done it 
is my computer i want it to do what i want ! Thank you very 
much, Tony from Toodyay West Australia 
 
XP is a multiuser system, even when only one person is using the 
machine. Ideally, you're supposed to create an "everyday" account with 
limited permissions, and use an Admin-level account only for system 
maintenance. That way, viruses, worms, and whatnot that may foul up the 
limited, everyday user account will be less likely to cause system-wide 
damage. So, even with just one person using the system, you get better 
safety and security by having two accounts. 
 
But a lot of people go in and stay in as Admin (or as themselves, with 
full admin rights). That's OK, as long as you realize that it's riskier, 
because trouble in an Admin-level account can spread system-wide in a 
flash. 
 
In any case, if you want to auto-login, bypassing the "click on your 
name" and going straight to your account: 
http://www.support.microsoft.com/default.aspx?scid=kb;en-us;315231 
http://www.google.com/search?q=automatic+login+xp 
 
The screen saver logon is different, but easily turned off: Right click 
anywhere on the desktop, select Properties, then Screen Saver, and 
uncheck the "On resume, password protect" box. 
From LangaList 12/4/2004 

HUMOUR 

13 thoughts for today 
13. Never take life too seriously. Nobody gets out alive anyway.  
 
12. Life is sexually transmitted. 
 
11. Health is merely the slowest possible rate at which one can die.  
 
10. Men have two emotions: hungry and horny. If you see him without an erection, make 
him a sandwich. 
 
9. Give a person a fish and you feed them for a day; teach a person to use the Internet and 
they won't bother you for weeks. 
 
8. Some people are like Slinkies... not really good for anything, but you still can't help but 
smile when you see one tumble down the stairs. 
 
7. Health nuts are going to feel stupid someday, lying in hospitals  
dying of nothing. 
 
6. Whenever I feel blue, I start breathing again. 
 
5. All of us could take a lesson from the weather. It pays no attention to criticism. 
 
4. Why does a slight tax increase cost you two hundred dollars and a substantial tax cut 
saves you thirty cents? 
 
3. In the 60's people took acid to make the world weird. Now the 
world is weird and people take Prozac to make it normal. 
 
2. Politics is supposed to be the second oldest profession. I have  
come to realise that it bears a very close resemblance to the first. 
 
And the number one thought for the day: 
 
1. You read about terrorists; most of them came here legally, but  t hey hung around on 
these expired visas, some as long as 10-15 years. Now, compare that to Blockbuster; you 
are two days late with a video and those people are all over you. I think we should put 
Blockbuster in charge of immigration.  
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NEWBIE CLUB TUTORIALS 
Tutorial... "Can You Remove A Shared File?" 
When you remove programs from your computer, using the Add/Remove 
Programs system, should you answer "Yes" or "No" to the question, "Do you 
want to remove a shared file?" 
Hmmmm. 
Shared files have the file extension ".DLL" on them. That means they're a 
Dynamic Linked Library file. All this means is the file in question can be used by 
different programs. A word processor and another program may share a DLL file. 
So removing that file may cause another program to malfunction. 
You may have seen a message stating that a certain file cannot be found. That file 
is needed in order to open the program you're trying to use. Why is it missing? 
Could be that you removed it when you uninstalled another program. 
The bottom line: If you aren't familiar with a filename, and you're asked if you 
want to delete it, don't. Just answer "NO" to the question. It won't do any harm if 
it's not actually needed. But watch out if it *is* needed - and you've removed it! 
More on .dll's later .… 
Tutorial ... "A .dll File Was Not Found - Excuse Me?"  
Here's two examples of emails that hit the Newbie Club email box in recent 
weeks. 
"Error starting program, a required .dll file was not found." I don't know how to 
get rid of it. Could you please help? 
"When starting windows, a screen comes up stating a required DLL file 
MSVBVM60.DLL was not found. When I click ok it goes away but I would like 
to fix whatever the problem is. I've tried several things with no success. Any help 
would be greatly appreciated. Thanks in advance." 
If you haven't seen that happen yet on *your* PC, you can bet your bottom dollar 
it's only a matter of time. 
A .dll file is explained in Tutorial above. 
Sometimes a .dll file disappears or is damaged, or is removed accidentally. And 
suddenly you find that one of your programs no longer works. The answer? 
Download another one from the Internet and install it. 
Go to http://google.com and type in dll in the search box. You'll be presented 
with a bundle of links to sites that let you download the .dll file you need from 
their .dll library. 
If you don't find the one you want first time, try other sites until you do. 

There are some sites that charge you, but you don't need to pay, because there are 
many more who offer free downloads. 
You will need to write down the number of the .dll file you need, then type it into 
the search box of the download site. Also look for a site that explains how to 
install it. Print out and follow the instructions and everything should then return 
to normal. 
DLL files are only tiny, but it's like a having a tiny fuse blowing in your auto 
engine compartment. When that tiny bit of wire blows, all that sophisticated 
technology grinds to a stop. 
That's techies for you:-) 
Tutorial ... "Storing Hardware" 
Adding new hardware to your computer isn't as easy as adding a new software 
program, but here's some tips to consider. 
First of all, know what's in your computer. That means, find out exactly what's 
hiding in there by opening the case, and checking it all out. Not very practical 
advice? OK, then dig around inside using software. The next bunch of tips tell 
you how. 
To see what processor is installed and how much Random Access Memory 
(RAM) you've got, right click My Computer (on your Desktop) and select 
Properties (or use the Windows Logo key+Pause, or hold down the Alt key while 
double clicking. 
To see what size your hard drive is, go for My Computer once again. Double 
click the My Computer icon to open, then right click the drive letter you're 
interested in (usually 'C') and click Properties. 
To see what type of video card (also called a video display adapter, or graphics 
card) you have installed, right click the Desktop, and choose Properties from the 
context menu. When you see the Display Properties dialog box, choose the 
Settings tab. You'll see the brand and model of the monitor installed (or it may 
just list "Plug and Play Monitor") along with the video card that makes it work. 
To see what kind of hardware is installed in your computer (that wasn't already 
covered above), open the Control Panel ( Start. Settings. Control Panel) and 
double click the System icon. Click the Device Manager tab for a complete list. 
Click down the list of installed hardware. You can click the Properties button 
after highlighting a particular item, and you'll see more details on drivers, 
settings, and other info that may just bore you to tears. 
Interesting stuff this. Just don't go messing around, ticking and unticking, unless 
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wallpaper to something that goes with the new Spartan look.  
Tutorial ... "Did I Copy It - or Move It?" 
Here's a tip which solved a long term irritation for me until I learned about it. 
Like many things to do with computers, it's easy once you know how. 
I move files and folders about by dragging them across in 'Explorer' (right click 
'Start', click 'Explorer) 
But Windows treats your dragged files differently if you're moving them around 
the same disk, or if you're moving them between disks. 
Drag a file from one folder to another, and the file is moved. But drag the same 
file to another disk that's separate from your hard disk, like a floppy or a Zip disk, 
and it's copied. 
NOT moved. 
Dumbness prevails - hey wake up at the back! 
If you want to get control of the situation, and always be presented with a 
verification of your intent, use the RIGHT drag method. Really. Just right click 
instead of left clicking when you drag an icon. When you release the right button, 
you'll see a context menu appear with these options: 
Move Here, Copy Here, Create Shortcut(s) Here, and Cancel. 
It sure beats not knowing what Windows will do next. 
If you don't like pressing the right mouse button for some reason, hold down the 
Ctrl and Shift keys at the same time while dragging with the left mouse button. 
You can press them before or after you click the mouse--it doesn't care. The end 
result is the same. You be presented with a context menu seeking your intent. 
Windows does try and aid you to some degree, changing the mouse cursor 
depending on the action taken. For example, a small plus sign (+) appears when 
you copy, and a small curved arrow appears when you're creating a shortcut. 
Tutorial: "File Maintenance Using Dialog Boxes" 
Note: A dialogue Box is another name the techies have dreamed up. It's just 
another 'window'. 
This is well kept secret, so tell everyone about it. You can do file maintenance 
using the OPEN and SAVE AS dialog boxes. 
When you see the OPEN dialog box (seen when you are about to open a file) or 
the SAVE AS dialog box (seen when you are about to save a file) you can leave 
those boxes on the screen and perform the following: 
> To do maintenance on a file or folder, right-click the object to display a 

(Continued on page 8) 

(Continued from page 6) 
you know exactly what you're doing:-)  
Tutorial: "How To Clean Up Your Clutter" 
What can you do with the various icons spread out like dew drops across you 
computer screen? Do you really need all 67 of them? Probably not. So let's clean 
up a bit, shall we? 
Icons are of course representations of the actual program. Not all icons however 
represent the actual physical location of the program they refer to. This particular 
breed is known as the shortcut icon. 
You can safely DELETE shortcut icons. You know it's a shortcut when you see a 
small arrow in the lower left corner of the icon. Also, you can double check 
yourself by RIGHT clicking any icon, looking at its PROPERTIES and you'll see 
if it's a shortcut or not. 
Every item that makes up the stuff you see on your computer screen (called 
"objects" in techie-speak) has associated properties. Just as there are properties of 
a pencil (it's cylindrical in shape, made of wood, has an eraser, etc.) there are 
properties of computer files. (Their size, the date they were created, where they 
live on your hard drive - called the "path" - etc.) 
So which icons can you safely remove? 
Well, here's a list of what you CAN'T remove. 
1. My Computer  
2. Network Neighborhood  
3. My Documents 4. Recycle Bin 
(Actually, you can even remove the above, but that's even more advanced, and 
you have to use a special program to do it.) 
Now, if you delete an icon, you'll receive a warning message if you're about to 
delete a program. So if you know nothing more than "I want to save anything 
Windows tells me is a program" and you just started highlighting icons and 
pressing the Delete key, you could safely remove anything that WASN'T a 
program. (You "highlight" an icon by clicking on it.) 
You can really clean up your desktop this way, and if you have stuff you 
REALLY want on the desktop, you can always create a shortcut - a NEW 
shortcut, fresh and useable - at any time. This is explained in Windows for 
Newbies, along with 50 other basic tutorials, along with dozens of tips and tricks. 
More on that here: http://newbieclub.com/wfncopy 
So clean up you desktop without fear of loss. Then redecorate by changing the 
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good, so that's not the reason for the returned email. 
Turns out the email message you received AFTER sending your email explains it. 
"The recipient's mailbox is over quota." That means the silly thing is plumb full 
of mail! This happens to web-based email, like accounts at Yahoo!, Hotmail, and 
the like. And maybe AOL, and Juno, and others. 
Any ISP who monitors the total number of bytes of mail stored in your inbox will 
'bounce' messages if the mailbox exceeds the ISP's mail quota. 
Every mailbox has a limit. If the next incoming piece puts you over the top, then 
the mail is "returned to sender. No such number. No such zone." 
Hmm, has your mailbox been cleaned out recently? 
If you go on a trip, and don't check your mail... well, you know what happens. 
Things fill up, and you're soon 'over the limit' if you get a LOT of email. 
So clean out those messages. Archive them. Transfer them to a special folder. Do 
whatever it takes.  
Tutorial: "How to Remove Programs Safely"  How to properly remove programs 
from your computer:  Windows 98 has added a little program that helps you 
delete applications safely and CORRECTLY. Why correctly? Because a lot of 
new software leaves entries in the Registry, and unless you uninstall your 
programs, the excess code gets left behind. Not so tidy. So when you want to 
uninstall an application, follow these steps:  1. Click Start. 2. Choose Settings 
then Control Panel. 3. In the Control Panel window, double-click the Add/
Remove Programs icon. 4. Under "The following software can be automatically 
removed by Windows..." select the application you want to remove. 5. Click 
Add/Remove and follow the instructions to remove the application. It will show 
you dialog boxes to assist you in the process.  When you remove programs, you 
may be asked if you want to remove files called "DLLs". That's an acronym for 
Dynamic Linked Library file. These are shared by other programs. If you want to 
be real safe, just answer "No" to the question. Everything but the files in question 
will be removed. (Everything related to the program you're uninstalling, of 
course.)  This is all very geeky, really. But the time may come when you need to 
uninstall something. So use this. Don't just randomly delete the files that make up 
programs, or you'll be in REAL trouble.  

(Continued from page 7) 
shortcut menu... 
> To create a new object, right-click an empty section of the file list, and then 
click New to get the New menu. 
> To create a new folder within the current folder, click the Create New Folder 
button. 
Here's an example of how to use this. Let's say you've begun downloading a file... 
and you're at the SAVE AS dialog box. While there, you think, "I need to create a 
new folder for this file so I keep my computer's hard drive organized." 
Click the Create New Folder button, and a new folder appears with blue covering 
the file name. Type the name for the folder, press Enter, and the new folder is 
created. Then select that new folder for the download location. Tutorial: "Adding 
Shortcuts to Your Start Menu" 
If you use your computer at all, you'll have some open windows on screen. 
Without closing them, the Start Menu provides access to lots of programs. But 
let's say you're lazy, and want a quick click solution... create a shortcut that 
appears on the Start Menu... so you don't have to chase down the program on the 
Programs Menu! 
Windows 98 and higher makes this real easy for you. 
Using the left mouse button, click on an icon and drag it from the Desktop (your 
main screen) and hold it over the Start button for a couple of seconds. You'll see 
the Start Menu open up. 
Keep holding the left mouse button down, and move the icon up to the area above 
the "Programs" time. You'll see a dark "bar" appear. Slide the icon up and down, 
and the bar moves up and down. Release the mouse button, and the icon that was 
on the Desktop is now on the Start Menu. 
If you want the icon to be in both places, Desktop *and* Start Menu, use the 
RIGHT mouse button when dragging the icon. When you release the button, 
you'll have options... choose the option to "copy here". 
If your computer is like mine, something will freeze up. My Start Menu got stuck 
and wouldn't close. What a drag. I had to reboot the computer to fix it. 
Why these things happen is unknown to human beings, but they happen. If cars 
were built the same way, we'd have stop and go traffic all the time. Tutorial: 
"Bouncing Email: Help Reduce The Rubber" 
Aye, it happens every day. "I sends out me email, and it bounces right back." I 
don't need another rubber ball! What's happening here? I know the address is 
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represented by another. In an analogue clock for example, the 
rotation of the hands is an analogue, a representation, of the rotation 
of the earth. Perhaps the most common analogue computing device 
was the slide rule, in which numbers, as logarithms, were 
represented as distances along the scales of the rule. In the late 19th 
century Lord Kelvin designed an analogue computer to calculate 
tides. The different components were represented by the positions of 
a set of pulleys, and the final result appeared as a graph. The most 
complex analogue computer was the DifferentialAnalyzer, built by 
Vannevar Bush at MIT in 1930. It worked to within 2% accuracy. 
Navigators have used analogue devices for centuries. The astrolabe 
was an analogue computer, as is the device used by fliers to solve the 
vector triangle problems of aerial navigation.  
Early days Arabic numerals and zero Numerals as we know 
them entered Europe in the eighth and ninth centuries, but the 
transition from the cumbersome Roman system took a long time, 
until the 17th century in places. Key to the new system was the idea of 
place value: units, tens, hundreds, etc. which made calculation much 
easier. John Napier (1550–1617) Napier was a Scottish 
mathematician whose major invention was logarithms. 
Multiplication could be performed as addition, and Henry Biggs 
published the first tables in 1617. Napier later invented a 
multiplication aid, Napier’s rods (or bones). They were widely used 
across Europe. Another of Napier’s inventions was the decimal point.  
William Gunter (1581–1626) and William Oughtred 
(1574–1660) Gunter devised a scale, based on logarithms, for 
multiplication. Oughtred rearranged the scales into two circles, 
making a circular slide rule, and later the linear version. Slide rules 
were in use until the late 20th century, and are still used for some 
specialised purposes.  
 

(Continued on page 10) 

A brief history of computing  
Peter Carter  
There was a time when I earned my living teaching some history 
and theory of computing, some programming, and the application 
of computing to life in general and education in particular. I 
therefore noted the suggestion written at the AGM with some 
interest. Now, I’m not sure exactly what the writer meant, but it 
looks like an excuse for a series of articles looking at machines and 
ideas of the past and how they have led to present day Macintoshen, 
together with a little programming. If we were still using the Apple 
II I could offer quite a bit of programming because the machine had 
a language built in, but programming the Mac is a very different 
proposition. I’ll keep thinking about that aspect. In the meantime, 
let’s start at the beginning…  
In the beginning  
Humans are calculating creatures. Recent research shows that 
animals and birds have some number sense, but humans have 
always wanted to keep track of numbers of things, whether it be 
sheep in the flock or the number of days to the next festival. Before 
there were mechanisms there were counters, often small stones. 
Our word ‘calculate’ comes from the Latin word for a small stone. 
calculus n. a stone  
Algorithms An algorithm is the set of rules and operations used 
to solve a problem or calculate a result. The term comes from the 
name of a ninth century mathematician working in Baghdad: 
Mohammed ibn Mûsû al-Khowârizmî (Mohammed, son of Moses, 
the Khowarezmite).  
When you learned to add, subtract, etc. you learned the algorithms 
for those processes. Any machine, such as those I describe below, 
must incorporate those algorithms in its mechanism. For our 
machines, the algorithms are in the software, expressed in a 
programming language. I’ll return to that notion in later articles.  
Analogue devices In an analogue device, one quantity is 
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Gottfried Wilhelm von Leibniz (1646–1716) Leibniz saw 
one of Pascal’s machines while on a visit to Paris in 1672, and 
decided to do better by producing a machine that would multiply, as 
well as add. The key invention was a stepped gear, a cylinder with 
nine teeth of different lengths. As far as is known, only one was 
built, and it proved not to be very reliable. However the principles 
within it were to lead to later, successful, machines. Another of 
Leibniz’s interests was binary notation, as now used in computers. 
He apparently thought of building a binary calculator, but nothing 
came of the idea.  
More mechanisms Leibniz’s stepped gear was the foundation 
for a succession of devices over the next 150 years: Hahn 
(Germany), Stanhope (Britain), Thomas de Colmar (France) being 
the first. In 1872 in the US Frank Baldwin devised a new 
mechanism, the pinwheel. In Sweden in 1878 Odhner came up with 
a similar machine, but real success came only when Felt, in the US, 
designed a key-driven calculator, the Comptometer. Burroughs 
developed a similar machine, and calculators like them were in use 
until well into the 20th century. But they were then soon to be 
outmoded, by ideas from two seminal 19th century thinkers, 
Babbage and Boole...  

(Continued from page 9) 

Wilhelm Schickard (1592–1635) Schickard was a 
polymath, and an associate of Kepler, the astronomer. Some time in 
1623 Schickard built what he called a Calculating Clock, 
presumerably to help with astronomical calculations. It used a set of 
Napier’s rods for multiplication, and a set of gears for addition. It 
was the first such machine, but it was lost during the Thirty Years’ 
War. It was not until the 1960s that Schickard’s work was 
rediscovered and a working replica built.  

Blaise Pascal (1623–1662) Pascal’s father was a tax official, 
and therefore needed to keep track of sums of money. The younger 
Pascal began work on a calculating machine in 1642. The first was a 
five digit machine, but later examples could work to eight digits. 
Numbers were set into dials in the top of the machine, and the 
result read in a series of windows. The machine could add only, and 
subtraction was by a method known as nines complements. The 
Pascaline was not particularly reliable, was expensive, and Pascal 
found that he was being undercut by cheap copies.  
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ADDRESS SEARCH. Hidden in your Windows 
98 is a feature you may be unaware of. Click 
Start|Find|People, and a window opens to allow a 
search from your existing address book or 7 
major search engines. Click on a name resulting 
from the search and more details are opened. 
Click on "Add to address book" and it does just 
that 

To create a zero with a slash through it  
On the Insert menu, click Field. In the Field Names box, click Eq.  
Click Field codes (toward the bottom of that dialog screen). Note Do not click Equation 
Editor or you will be lost forever.  
In the Field Codes box type EQ \o(0,/) . You can copy and paste that from here. Click 
OK.  
Now, select the slashed zero, right-click, and then click Toggle Field Codes. Remove the 
extra space after the right parenthesis.  
Right-click again and click Toggle Field Codes . (Yes again.) The result should be a 
beautiful zero with a slash through it. Good for you!  
Now, let's all create an AutoCorrect entry that will let you type in something that stands 
for the slashed zero and have the actual, slashed zero appear (without having to go 
through all that you did above).  
To create an AutoCorrect entry for a slashed zero Select the slashed zero in your 
document. On the Tools menu, click AutoCorrect Options. In the Replace box type 
whatever combination you want Word to turn into a slashed zero.  
An example is *0. Click OK. Get on with your life.  
White space: Show it, hide it, make up your mind This next tip comes from my next-
door neighbour here at work. Can you even imagine how fantastic it is to have a Word 
expert right next door? Of course you can't; that's why you're reading this. Some of you 
like to work in Print view and some of you like to work in Normal view. I personally like 
Print view but all that white space gives me a headache. Here's a neat little trick that will 
give you the best of both worlds: Hide all that white space on the top and bottom of each 
page and still remain in Print view.   
To show or hide white space in Print view Move the insertion point to the top or bottom 
of the page and click when you see Show White Space or Hide White Space  
Orientation: Turn this way and that way and away we go I get these whiny e-mails all 
the time about how WordPerfect can rotate text, and so why can't Word? Slander, I say! 
Libel, I shout! Word can rotate text (and I don't mean just WordArt either). The only 
thing is, to change the orientation of text, the text must be in a text box or a table cell. 
How difficult is that? To rotate text in Word Click the drawing object or table cell that 
contains the text you want to change. On the Format menu, click Text Direction. Click 
the orientation you want.   
Drawing canvas: Turn it off and stop your crying And speaking of whining, users of 
Word 2002 have clogged servers worldwide with their nasty e-mails about (and I quote) 
"That jail that appears when I try to insert a piece of art" "That imaginary boundary that 
I'm always fighting" What these creative (not to mention crazed) people are talking about 
is this:  
When you insert a drawing object (a graphic you draw or insert and that can be changed) 

(Continued on page 12) 

Microsoft Office Assistance:  
Crabby's top 5 Word 2002 tips and tricks  
By The Crabby Office Lady  
Here are five of my best Word tips in all their glory.  
Today we'll talk about altering the Normal template once and for all, how to create a zero 
with a slash, reduce the glut of white space in print view, orient your text, and turn off the 
much-maligned drawing canvas.  
Applies to Microsoft Word 2002   
Microsoft Word is one of the most widely used Office programs. Some of you may think 
that to use Word, all you need to know is how to type, create and open documents, save, 
and enlist the aid of the spelling checker. That's basically true. But for Crabby's sake, 
expand your horizons a little, will you? Think of me as your tips and tricks diving 
instructor: Put on your wet suit, stick that snorkel in your mouth, and let's plumb the 
depths of Word.  
The Word template: Why be Normal? Sometimes the Normal template (the one that 
opens each time you create a new document in Microsoft Word) isn't exactly laid out as 
you'd like. Okay, so you tweak it each time, but what a time-waster that is! Why don't you 
just set up the Normal template to look exactly as you want it to?  
Good question. To change the Normal template Click Start > Run > and then type (or 
copy): C:\Documents and Settings\your user name\Application Data\Microsoft
\Templates. Select the file Normal.dot. On the Edit menu, click Copy. Click anywhere in 
the folder, and on the Edit menu, click Paste.  
Right-click that original Normall file, click Rename, and rename it Default (or whatever 
you want).  
Right-click the copy you made, rename it Normal. Right-click the new Normal, and click 
Open. (Don't just double-click it as that would open a new document, and we want to 
open the template itself). Make any kind of changes you want-(change toolbars, views, 
default fonts-) anything at all. Then, on the File menu, click Save. By naming the new file 
Normal, you've created the new template that Word opens automatically. It's a beautiful 
thing. 
It's a zero, it's an O, it's Super Symbol! Yes, like you, I once naively believed that a 
zero with a slash through it- - would appear in the Symbol dialog box that you get to from 
the Insert menu.  
But alas, it doesn't, so when I wanted to use this symbol, I had to take matters into my 
own hands.  
The procedure below applies to Word 2002, One more thing: Thanks to Woody's Office 
Watch for noticing a missing step in an earlier version of this column, as well as for 
providing the inspiration to update the information from the above-referenced Knowledge 
Base articles.  
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(Continued from page 11) 
into Word, the drawing canvas is placed around it.   
The drawing canvas is supposed to help you arrange your drawing in a document, and it 
works great if your drawing consists of several shapes. Many of you also wrote to me 
about how hard it is to position drawing objects in Word; that's what the drawing canvas 
is for.  
(No, it wasn't created just to torture you and give me something to do.) That being said, if 
you're so torn up about it, turn it off so that we can give my e-mail server a break!  
To turn off the drawing canvas On the Tools menu, click Options. Click the General tab. 
Under General options, deselect the last option, Automatically create drawing canvas 
when inserting AutoShapes.   
About the author The Crabby Office Lady gets her column ideas from your far-out 
suggestions and demands. If you're feeling far-out or just have something to say, send her 
some Feedback. While she can't answer your mail, you may see a solution to your 
problem in a future column. Office Worldwide Â© 2004 Microsoft Corpor ation. All 
rights reserved.  

Lolo’s Corner  
A2A Update, January/February 2004 The January A2A database update has taken place at 
<http://www.a2a.org.uk>.  
The database now contains more than 6 million catalogue entries describing archives held in 340 
record offices, libraries and other repositories throughout England. Among the 1411 new 
catalogues are finding aids describing the following:  
• oral history recordings, photographs and other unofficial archives relating to the miners’ 

strike in the 1980s, held at Sheffield Archives and submitted by the Shafts of Light project;  
•  catalogues of archives held at 5 museums - whose holdings are thus described on A2A for 

the first time - namely: the Watts Gallery in Surrey (catalogues contributed through the 
South East regional project Private Faces in Public Places), the Manchester Museum of 
Science and Industry and the Maritime Archive of National Museums Liverpool (through the 
Mills, Mansions and Corner Shops project in the North West), and Brixham Heritage 
Museum and Cookworthy Museum (through South West Family Fortunes); * 

• estate archives of the Chichester-Constable family dating back to the 12th century, held at 
East Riding of Yorkshire Archives and Records Service and submitted by the regional 
project Broad Acres, Big Houses, Yorkshire People; * 

• a wide variety of archives, including personal papers, deeds, manorial archives and records 
of local organisations, held by the archives services of Berkshire, Buckinghamshire, East 
Sussex, West Sussex and the Isle of Wight, contributed through the Aladdin’s Cave project 
in South East England; * 

• and various public records held locally, including coroner’s records held at Berkshire Record 
Office and Lincolnshire Archives, and records of local pre-1974 urban and rural district 
councils held by Wigan Archives Service. Following user evaluation held in 2003, a number 
of enhancements have also been made to the A2A site in conjuction with the database 
update. These enhancements include:  

•  redesigning and renaming the Special Interest (index) search as People, Places and 
Subjects;   

• simplifying the operation of the People, Places and Subjects search, including clearer online 
help and removing the necessity to use an * 

• in the search; * 
• adding to the Standard Search and Extended Search the ability to search by the date that 

catalogues were actually uploaded to the database; * 
• and adding to the Extended Search the ability to search for creator(s) of archives by 

keyword.  
Technical enhancements have also been made, comprising a new server, a new operating 
system and upgraded database management software. The new content and enhancements are 
only available at the new A2A URL <http://www.a2a.org.uk>. The site at the old url at .pro.gov.uk 
is no longer being updated, so please change your bookmarks/favourites to the new URL, and 
amend any web links you may have. Lastly, A2A usage since launch has now reached 2.85 
million database searches, with 5.95 million catalogue downloads as a result. A2A is the English 
strand in the UK archives network: its database at <http://www.a2a.org.uk> already contains the 
electronic equivalent of over 400,000 catalogue pages describing archives held across England 
in national, local and specialist repositories and dating from the 700s to the present day. The 
A2A programme will make a further 300,000 catalogue pages available on the web by March 
2004.  
From ACT Apple March 2004 
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Cleaning Keyboards  
Patricia Lane  
This is March, and with the First of April not that far away, I thought I’d include something 
special to commemorate that date. If you are going to experiment with the processes de-
scribed below, you are doing so entirely at your own risk. I’ll take no responsibility for what 
might happen – Ed. ACT Apple 
Keyboards are abused peripherals. We spill sodas and coffee on them. Our food crumbs 
hide in them. Our cats lie on them. Smokers accidentally flip ashes on them. I’ve even 
heard of one person who “accidentally” blew out a large candle near hers and covered the 
keys in hot wax. To keep your keyboard clean, try to set ashtrays and drinks away from 
the keyboard. Sometimes this isn’t possible. So you can also buy a keyboard cover for 
around $US20 (which is about the cost of a new standard keyboard). Before you go out 
and buy a new keyboard, the “innards” of one can usually be cleaned. You’d be amazed at 
how much better the keys respond after a thorough cleaning. First, let’s talk about the ba-
sics of what makes a keyboard work and what it contains. The visible part of a keyboard 
consists of 101, 104 or more keys or keypads. Some of these keys, such as the spacebar, 
have springs attached underneath them. When you press down on one of the keys, you 
are actually pressing down on small “rubber plunger domes” under the keypads. These 
rubberdomes are attached (glued) to a clear plastic circuit board. Some keyboards have 
what is called a membrane. A membrane is actually a one-piece rubber pad with extruding 
domes. When you read about “quiet” keyboards, they usually have membranes.  
The clear plastic circuit board, called the key matrix, lies on the bottom half of the ke y-
board case. The wire coming out of your keyboard attaches to the clear plastic circuit 
board and then to your CPU. This circuit board is called the key matrix because it is a grid 
of rows and columns of wires.  
Each key acts like a switch. When you press a key, the dome, in turn, completes a circuit. 
The computer then identifies the correct keystroke.  
Now that you know the basics of how your keyboard works, let’s clean all of the gunk out 
of it! There are three ways to clean your keyboard.  
The first is with a can of compressed air, the second is a very radical way that I haven’t 
tried, and the third method is thorough (which is the method that I use). If you have a ke y-
board “cover” you can simply remove the cover and clean it. But this isn’t nearly as much 
fun.  
The standard cleaning method used on a keyboard is a can of compressed air. I find that 
this just redistributes a lot of the debris in the keyboard, makes a mess, and can actually 
make keys stick. If you’d like to try this method, turn your system totally off. Unplug the 
keyboard and take it outside. Using the can of compressed air, blow between the keys. A 
lot of dust and debris will be blown out this way.  
One of my professors swore by the dishwasher method to clean keyboards. I haven’t tried 
this, as I don’t have a keyboard that I’m willing to experiment with. Three things bother me 
about this method. One, I don’t want cat hair in my dishwasher. The second is that water 
gets awfully hot in a dishwasher. The third thing that bothers me is what happens if I forget 
to turn the “heat dry” off? I will have a melted keyboard in my dishwasher. For those of you 
who want to try to clean a keyboard in the dishwasher, make sure you put the keyboard on 

the top rack with it upside down (keys facing down). Do not use heat to dry. Turn the “heat 
dry” feature off. It will take a few days for the keyboard to thoroughly dry out, so you will be 
without your computer until is dry. Dry it by placing it upside down on a towel. Do not put a 
laptop in the dishwasher. People have actually done this! I have a friend who took his key-
board to the carwash. I really don’t advise doing this. It took forever to dry out and it never 
was quite the same.  
My method of cleaning a keyboard is thorough – it is not for the faint at heart. This isn’t 
meant to stop you from using my cleaning method. It is meant as a caution – for you to 
take your time so you don’t accidentally ruin your keyboard. Not all keyboards are exactly 
the same. I have cleaned several different brands/types of keyboards using this method. 
However, please don’t blame me if it won’t/doesn’t work on your particular keyboard. This 
won’t work on ancient keyboards or laptops. You need to turn your system totally off. Un-
plug the keyboard from the back of your CPU. Take the keyboard to the kitchen table. 
Grab a Phillips screwdriver, a small bowl, a few Q-tips (cotton buds – Ed) soaked in water, 
a towel, and then sit down. Let everyone know you are busy concentrating on a compl i-
cated electronic device and can’t be disturbed. :o)  
Remove the wrist rest, if you have one. Turn the keyboard upside down on the towel. You 
will see 8-12 Phillips head screws on the back of your keyboard, although you may have 
more or less. Remove these screws and place them in the small bowl. Throw the cat in the 
spare bedroom when she tries to play with the small screws. When you have all of the 
screws removed, use both hands to place the keyboard right side up. Don’t let it come 
apart yet. With the keyboard right side up, lift the top of the keyboard off. If it seems to 
“stick”, use your fingernails or a small common screwdriver to carefully pry it apart. Set the 
top to the side for now. You are now looking at the plastic circuit board and rubber domes. 
If you don’t have individual domes, you are looking at the membrane. Use the dampened 
Q-tips to remove any obvious dirt or grime from the domes or membrane. Be careful of the 
rubber domes! You can unintentionally knock these loose.  
If this happens, you can usually tell where a dome went – a small circle of glue will be visi-
ble where the dome belongs. Do not glue them back. Now take the top half of the key-
board either to the kitchen sink or the bathtub, wherever you have a sprayer available. 
Spray it down with a cleaner such as 409 or Lysol. Use a sponge and clean both sides of 
the keyboard top. Stand the keyboard up in the sink and spray it down with warm (not hot) 
water. You can clean your wrist rest also. If you have cats, dogs, or anyone with hair on 
their head in your household, you will notice hair coming out the edges of the keypads. 
This is normal. Continue to rinse both sides until you think it is clean. Turn off the water. 
Peer in between the keys to make sure you have removed all the foreign objects lurking 
between the keys. Use a pair of tweezers if required. Rinse again if necessary. When you 
are satisfied that it is clean, gently shake the keyboard out (I do this in the tub) to remove 
as much water as possible. Then lay the keyboard on a clean towel and pat it dry. Make 
sure the keypads are totally dry on both sides before you put it back together.  
I sometimes use a blow dryer (low heat!) to finish the drying process. When the keypad 
part of your keyboard is totally dry, take it back to the table. If you had any loose rubber 
domes, make sure they are in the correct spots. You can usually tell by comparing the 
backside of the keypads to the locations of the domes. The keypads will have a small re-
cess that lines up with its dome. Gently lay the top of the keyboard on the top of the key-
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board base. Line up the wire that goes to your CPU so that the whole unit fits together 
snugly. If you had a loose dome, test the key now. If it isn’t working right, remove the key-
board top, re-align the dome, and replace the top.  
Patience is the key (pun intended) when trying to re-align a misbehaving dome. When you 
have the keyboard to your liking, hold it together using both hands and turn it upside down. 
Replace all the screws and tighten them snugly.  
For you guys out there – this doesn’t mean using an impact wrench. Replace your wrist 
rest, if applicable. Take the keyboard back to your computer and plug it back into your 
CPU. Turn your computer on and your keyboard will be working like new.  
©2003 Patricia Lane  
From ACT Apple March 2004 

The road to Longhorn  
The next release of Windows is set to be as big a change from XP as Windows 95 was 
from Windows 3.1.  
At the foot of the sleepy ski resort of Whistler Mountain in British Columbia, just off a 
small road called Blackcomb Way, lies the Longhorn Saloon and Grill – an enticing 
restaurant that serves up food and drink to provide, in their own words, “the perfect 
ending to a day on the mountain”. The Longhorn Saloon is where people go when they’re 
through with Whistler, which is curiously similar to the situation Windows users are in. 
Whistler was the codename for Windows XP, and Longhorn is the codename for the next 
generation release of Windows, supposedly due in 2005.   
Windows, codenamed Longhorn, isn’t just a new GUI (Graphical User Interface), nor is it 
an evolutionary build of Windows XP. Instead, Longhorn is the culmination of several 
key Microsoft initiatives from the past few years, including .NET, DirectX, SQL Server, 
Trustworthy Computing, MSN Messenger, and Windows Installer.   
Although Longhorn isn’t due out in the shops till 2005, Microsoft has taken great pains to 
ensure that Longhorn is on everyone’s lips. In order to keep people talking about it, 
Microsoft has put out a number of pre-alpha releases of Longhorn. These act as 
technology previews of what the final release might look like, and enable developers to 
work towards the new operating system. With over 18 months until release date, these 
releases have been more showcases than previews, and the majority of new features 
planned for Longhorn have yet to materialise.   
Three pillars   
Longhorn brings with it many fundamental changes to the Windows platform. Microsoft 
has encapsulated the changes under the banner of WinFX. This can be broken down into 
four key technology ‘pillars’; Fundamentals, Avalon, WinFS, and Indigo.  
Fundamentals is the operating system core we’re used to from Windows XP, but is re-
engineered to properly follow Microsoft’s Trustworthy Computing mantra. It includes 
new ‘ClickOnce’ technology to make installation and maintenance of software much 
easier.   
Avalon is a completely new graphics system that’s intended for use on all future 
Longhorn-based applications, replacing older systems like GDI and GDI+. Avalon 
powers Aero, which is the new graphics engine, and does away with the old, component-
based system of Windows development. In its place we get an all-new, vector-based 
system that keeps user interface information stored in a dialect of XML, known as the 
XML Application Markup Language (XAML).  Much work is being done on the next 
release of DirectX (tentatively named DirectX Next) to offer better throughput of 
primitive shapes, and the Longhorn desktop will render all of its display through DirectX 
for maximum aesthetic effect. Demos have already been shown where windows have 

(Continued on page 15) 
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arrive. As a result, Microsoft will have had over four years to develop Longhorn into a 
product that will be as popular in big business as Windows 2000. There are three key 
technologies that will drive this. The first is Next Generation Secure Computing Base 
(NGSCB), an initiative most of us know by its original codename, Palladium. Many 
stories and rumours regarding Palladium have circled the web since it was first 
announced, with people saying it will remove all freedom from computing, that it will 
lock you into Microsoft and certain hardware manufacturers, and that it will stop you 
using unauthorised software (that is, software that ‘they’ don’t want you to use). Some 
parts are true. Microsoft has said that “much of the NGSCB architecture design is covered 
by patents, and there will be intellectual property issues to be resolved. It’s too early to 
speculate on how those issues might be addressed.” If patents are involved, running 
NGSCB hardware almost certainly means lock-in, so be careful what you commit to. If 
this 1984-like event doesn’t materialise, NGSCB has the potential to help companies 
form stronger and more secure networks. It has a finely grained trust system that’s built 
from the hardware up, meaning that when someone sends you an email, you can verify 
that it came from that person and their system.   
From a software management perspective, one of the new features being introduced in 
Longhorn is ClickOnce. This is anticipated to enable easy installation, maintenance, and 
uninstallation of software. This feature, which is being introduced in the next version of 
Microsoft’s Visual Studio.NET development tools will also allow dynamic updating of 
applications in roughly the same manner as Windows Update currently works. The plan 
here is that by keeping applications patched, one set of security issues can be struck off 
the check list.   
One area that’s sure to please CTOs the world over is platform compatibility. Longhorn is 
available in three different flavours for three different architectures – one for x86 
(Pentium-class hardware), one for AMD64 (Opteron and Athlon64), and one for ia64 
(Itanium and Itanium 2). As a result you can standardise your OS irrespective of the 
hardware you choose. We believe that the ia64 build may not ever be released given the 
current success of the architecture, but it’s possible that Intel may cut a deal with 
Microsoft to keep its ailing flagship alive.   
Home users  With increasing competition from Apple OS X, a lot of work is going into 
Longhorn to bring it up to speed. The most obvious change will be the new user interface, 
brought about through Aero. Right now the Longhorn releases all sport a dark grey 
interface, christened ‘Slate’, but this will definitely be changing before Longhorn is 
released. The new sidebar is designed to build on the usability enhancements brought 
about by the taskbar in Windows 95, and is currently a great way to keep your taskbar 
clear. Despite the best efforts of Windows XP to group programs together into one 
button, the system tray and the quick launch icons on the taskbar clutter it up. This is all 
being moved to the sidebar, along with new things such as the Slideshow, a much-

(Continued on page 16) 
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been transparent, rotated, scaled, and warped, while still retaining their functionality. This 
is made possible by the vector UI system and DirectX rendering. In order to keep the 
desktop clear of animated clutter and glitz for business users, the new Aero-style interface 
can be downgraded to a more traditional style by the administrator, although this will take 
place automatically if you don’t have the required graphics hardware.   
WinFS is a new file system that’s integrated with some of the technology Microsoft 
developed for use with SQL Server, codename Yukon. This is a product that will 
eventually be SQL Server 2004 or SQL Server.NET. The plan is to use the existing NTFS 
file system that we’re used to from Windows 2000 and XP, and to add proper support for 
metadata. Metadata is “data about data”, and will be used to describe the contents of the 
files on your hard drive. Much of this was already in Windows XP. If you convert a 
music CD to Windows Media Audio format when online, Media Player will auto-connect 
to an online CD music database to get the name of the artist, the name of the tracks, the 
year it was recorded, and the genre for the CD, storing that information inside each file. 
What’s new in Longhorn is the ability to look at your hard drive through a metadata-
filtered view. For example, you could sort your music folder by artist, even though the 
artist’s information isn’t stored in the filename itself but in the metadata. It’s possible that 
this will only be available in the My Documents folder in the Longhorn release.   
The final component in the three pillars is Indigo. This is the communications layer 
that’s designed to both bring together all the advances Microsoft has made in its move to .
NET, as well as bringing in a new set of technologies at the same time. Combining 
various disparate parts of .NET into one API means that developers will be able to access 
a selection of protocols and security measures all through one interface, which in turn 
should help to increase security, whilst adding a great deal of flexibility at the same time. 
End users can expect applications to work together much more smoothly if all of 
Microsoft’s hopes for Indigo come true. It will finally bring the power of web services to 
the desktop in a way that everyone can use. Microsoft has committed to back-porting the 
Indigo subsystem to both Windows XP and Windows 2003, which should help its 
adoption.   
New features and technologies are all well and good, but to really understand what 
Longhorn offers, you need to look at it from the viewpoint of the three types of user who 
will buy it; enterprise users looking to deploy to hundreds or thousands of desktops; small 
office and home users looking to work smarter with their existing resources, and 
developers looking to take advantage of the latest technologies.   
Big business  Despite Windows XP having been out for some time now, Windows 2000 
continues to be the most popular enterprise desktop system in use,. For the large part, this 
is because it’s easy to manage and very stable. Responding to repeated requests from its 
customers to lengthen its Windows product cycle, Microsoft will make Windows XP last 
from late 2001, when it was released, to late 2005/2006 when Longhorn will finally 
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improved clock, a PDA synchronisation tool, and potentially dozens of other third -party 
plug-ins. Much of ‘Slalom’ (the version of Windows Media Center that will follow on 
from ‘Symphony’, which itself is the version to follow on from Windows Media Center 
2004) will be based on Longhorn, which means that we may be seeing some innovative 
uses for the sidebar by the time Longhorn finally launches – scrolling RSS news feeds, 
anyone? Of course, it’s questionable how much differentiation will be kept between 
Longhorn and Windows Media Center. Microsoft is indeed likely to import features from 
Media Center into the main Windows branch in order to add more  
“Why upgrade to Longhorn?” bulletpoints.   
The addition of WinFS means that you can treat data from various programs on your 
systems as files you can search through. When searching for files and folders, you can 
also search for contacts, music by certain artists, and so on. This was one feature that was 
missing from the metadata functionality found in Windows XP, and is now possible 
thanks to the Yukon code in Longhorn. If Microsoft does get this feature nailed down and 
in operation for more than just My Documents, it opens up numerous possibilities. These 
include the ability to search for documents with very specific information, such as 
“Written to NatWest Bank, from me, in October”.   
On the usability front, a new version of Internet Explorer (IE) is now bundled with 
Longhorn, and sports a newer, simplified interface. The key toolbar buttons are currently 
so large that some might even consider it ‘dumbed-down’. This is of course the first 
release of IE since Microsoft announced they would stop shipping it as a standalone 
package, so it’s no surprise to see that IE is wholly Longhorn-ified. There are some new 
features around, of which the most interesting are the new pop-up blocking tool and a 
download manager. In our opinion, these are changes that are long overdue. Whether or 
not we’ll also see tabbed browsing in the finished release is yet to be seen, but given that 
all other major browsers now do it, there‘s little reason not to.  
The chances of DirectX Next – the successor to DirectX 9 – introducing anything 
interesting from a gaming perspective are fairly low. None of the cards currently on the 
market are even near taking full advantage of DirectX 9, with games that take full 
advantage being even further away. With DirectX X – as it may end up being called – 
pushing the envelope further, don’t expect to see many compliant games until 2007.  
For developers  Longhorn heralds a new programming paradigm from Microsoft, 
codenamed WinFX, and encompasses a trio of core changes to the Windows 
programming model. Comprised primarily of Avalon; the display subsystem, Indigo; the 
communications layer, WinFS; and the Yukon/ SQL Server 200x-based database file 
system, Longhorn also incorporates a variety of other codenamed projects that are 
currently in production: these include ‘Whidbey’ (the .NET codename), which comes as 
part of the new Visual Studio .NET release, and XAML, the new declarative way to 
design your GUIs. While this is all great from an innovation point of view, it does mean 

that developers can expect to have to rewrite their applications from the ground up.  
Currently we have .NET Framework 1.1. This is to be superseded next year by .NET 
Framework 2, currently codenamed Whidbey, which is a stepping stone to WinFX on 
Longhorn. Although it will be possible to run Windows Forms on Longhorn, Microsoft 
recommends Avalon for use on Longhorn. Mark Boulter, a Microsoft developer, said at a 
presentation at the Professional Developers Conference 2003 (PDC2003),  
“if you’re targeting Longhorn, only use Avalon. If you’re targeting multiple versions of 
Windows, use Windows Forms. Use adaptive techniques to get the best of both worlds”. 
Mr Boulter says to build applications that detect and use Longhorn features when 
available, “replacing Windows Forms GridView with Avalon ListView control when 
running on Longhorn”. 
We have a feeling that this is easier said than done, and that Microsoft is playing down 
the changes required to migrate to Longhorn.   
XAML will be especially difficult. The idea behind XAML is that it splits off GUI design 
from the code that drives it, which is all well and good – this technology has been around 
in GTK and Qt for some time, and has been proven to work. This certainly has its 
advantages, and the abstraction means that the UI can be ported easily to other 
environments such as mobile phones and PDAs. It also means that professional GUI 
designers can take care of the application layout using tools such as Visio while 
programmers plug in the actual business logic behind the scenes. On the downside, this is 
absolutely nothing like the way Windows currently works, and is likely to throw many 
developers off the track. We’ve been testing XAML for about a month now, and it’s 
damn impressive. There’s no doubt that it will catch on, but the question is, how many 
developers will need to be dragged along kicking and screaming by Microsoft?   
To make this as easy as they can, Microsoft has at least made the Avalon APIs somewhat 
interoperable with Windows Forms. To help you preserve your existing .NET 1.1 
investment as you migrate your apps to Longhorn, you’ll be able to embed your existing 
dialogs directly inside Avalon applications. Furthermore, to help you learn how to take 
advantage of the new Longhorn APIs, you’ll also be able to embed Avalon inside 
Windows Forms applications, although this isn’t likely to be a route chosen by many 
developers.   
It’s all coming soon  The official release date of Longhorn is 2005, but we wouldn’t be 
surprised to see that slip to Q2 2006, if not later. This causes a problem for customers 
who have to live with the prospect of no operating system (OS) upgrades for about two 
years, despite having been on the same OS for two years already. On the upside, this does 
give the industry a long time to get up-to-date. Too many machines are still running 
Windows 98 and Me for Microsoft’s liking, and a long break will help people at least get 
up to XP before Longhorn comes along.   
When the announcements of Longhorn’s release date were first aired, many thought it a 
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foregone conclusion that there must be a Windows release between XP and Longhorn. 
This seems increasingly unlikely, as Microsoft has committed to so many changes and 
upgrades in Longhorn that any interim OS release would cause more problems than it 
would solve. Even a Windows XP Second Edition would add to the upgrade path chaos. 
Instead, Microsoft’s plan seems to be to backport many Longhorn features to Windows 
XP in the form of service packs. XP SP2, for example, will be compiled using Visual 
Studio.NET Whidbey, and will incorporate new security restrictions along the same lines 
we’ll see in Longhorn. This will help prepare end-users and developers for the switch in 
2005. Back in British Columbia, Blackcomb Way leads people away from the Longhorn 
Saloon, so it’s not surprising that Microsoft has codenamed the post-Longhorn release of 
Windows as Blackcomb. It’s not known if there’s anything planned for this release 
beyond its approximate 2007/2008 release date, but Microsoft rarely has less than a five-
year strategy plan. Paul Hudson 
The highlights  If you decide to make the upgrade, these top eight features provide a 
wealth of  possibilities.   
The sidebar An extension of the task-based workflow first  showcased in XP. Third-party 
developers will be able to write custom apps to give the sidebar helpful add-ins for you to 
choose from. You can  also make the taskbar merge with the sidebar so that everything is 
together, but it’s a little  cluttered right now.   
WinFS The new database extension to NTFS allows you to  store custom information 
about each file on your hard drive. Explorer will be programmed to take full advantage of 
it. This will be particularly helpful in the Find dialog, where you can search  for more 
specific information, such as Contacts.   
Avalon The new .NET-based graphics API for Longhorn that will take advantage of 
features found in new graphics cards. Avalon also powers Aero, and will automatically 
downscale effects if the  hardware isn’t up to scratch.   
ClickOnce Install, update, fix, and remove software using this unique new technology 
available in .NET 2. It takes the best parts of web services (easy  deployment, access over 
the web), and brings it  to Windows development.   
DirectX Next Games will be taking full advantage of DirectX 9 by about Q1 2005, so 
Microsoft are pushing the barriers even further with the next release of  their popular 
games API. Look for v4 of pixel and vertex shaders.   
Visual Studio.NET Whidbey Brings with it .NET v2, which takes the existing  .NET 
system and adds to it many of Longhorn’s new features. Great for developers, and should  
be on sale in Q4 2004. This is the easiest way  to migrate your apps to Longhorn.  
NGSCB (Next Gen Secure Computing Base) Previously known as Palladium, this Big  
Brother-esque technology could either be used to  bring full Internet security to all users, 
or to  take control away from the users. Only time will  tell what Microsoft has planned 
here. However,  it does require a lot of collaboration with  other vendors, which may be 
its downfall.   

Aero The new user interface system for Longhorn that  uses vectors to allow smooth 
scaling and warping, then renders the entire system through DirectX for maximum 
performance. Mac OS X continues to move quickly in the “lickably good”  user interface 
arena, and this is Microsoft’s first salvo in return. PC Plus Issue 214 - April 2004   
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Firewalls: your first line of defence 
Dan DiNicolo analyses the features of hardware and software firewalls, to give you a 
better idea of what’s best for you 
When it comes to managing a home or small office network with a broadband Internet 
connection, the implementation of a firewall should never be overlooked. While nobody 
will dispute the importance of having a hardware or software firewall from a security 
perspective, many users aren’t familiar with the many features that firewalls support. A 
firewall was once considered a device that would determine which TCP/IP traffic could 
exit or enter a network. But the firewall of today also includes a wide range of advanced 
features, enabling you to control everything from the email attachments that should be 
quarantined, through to privacy features like 
the ability to block cookies. 
This feature takes a look at different firewall 
components, as well as the differences 
between soft and hardware-based firewall 
solutions. Once we’re done, you should have a 
better idea of the firewall solution that will 
work best for you and your network setup. 
Why a firewall? 
At the most basic level, the firewall’s main 
purpose is to act as a secure intermediary 
between your private network and the 
Internet. For example, you might decide that all the systems on your internal network will 
have unrestricted access to any and all services on the Internet, such as web, FTP, ICQ, 
and so forth. Similarly, you might want to block internal users from accessing the Internet 
with certain programs, such as file-sharing services like Kazaa. Regardless of which 
camp you fall into, the configuration of almost any firewall will allow you to control the 
type of traffic permitted on your network. 
For most users, the primary reason for implementing a firewall is to keep the bad guys 
(aka the Internet at large) out of your network. In the default configuration of most 
firewalls, all traffic originating on the Internet is blocked from entering your network, 
denying external users the ability to connect to your private network. Of course, there will 
be times when you want to be selective about the type of traffic that enters your network. 
If you host your own internal web server, for example, and want Internet users to be able 
to connect to it, you’ll need to configure the firewall to both allow this traffic to enter, 
whilst also forwarding the request to the specific internal system on which your web 
server software is running. 
The implementation of a firewall is all about configuring rules about which types of 
traffic can move in or out of the network. The default rule for internal systems making 

outgoing connection attempts might be configured so that ‘any internal system (the 
source) can connect to any Internet system (the destination) for all types of TCP/IP 
traffic’. Similarly, the default rule for external systems trying to make incoming 
connections is usually something along the lines of ‘any Internet system (the source) can’t 
connect to any internal system (the destination) for all types of TCP/IP traffic’. In other 
words, the first rule authorises all internal systems unrestricted access to the Internet, 
while the second blocks all Internet systems from accessing systems on your private 
network. The screenshot above illustrates the act of blocking a single PC on a private 
network to prevent the Internet from using MSN Messenger. If you keep in mind that the 
configuration of a firewall is mainly about configuring rules for the interactions between 
systems on your private network and the Internet, you’re well on your way to 
understanding what a firewall is all about.  
Hardware versus software 
Once you understand why you need a firewall and its primary purpose, it’s time to go 
about determining whether a software or hardware solution will work best for you. As a 
general rule, users looking to protect a home or small office network will do best with a 
hardware solution. Those with a single PC are likely to find a software firewall more 
cost-effective. In the hardware arena, the most popular option for a home firewall is 
found in the form of an Internet router (such as those available from companies like 
Linksys or SMC). These relatively inexpensive devices usually include a range of 
features, such as the ability to share a broadband cable or DSL Internet connection, a 
firewall component, and an integrated DHCP server for allocating IP addresses to systems 
on your network. From a simplicity standpoint, the convenience of managing a single 
device for sharing Internet access and providing firewall functions is hard to beat. 
As you might expect, a hardware firewall isn’t the best solution for everyone. While 
generally associated with broadband Internet connections, having a firewall in place is 
just as important for the networks of PCs that use dial-up. Dial-up connections to the 
Internet may be slower, but systems using them still face the same security threats as 
systems connected via broadband. In cases where you’ve got a single PC dialling into the 
Internet, or even multiple systems sharing a dial-up or broadband Internet connection via 
a Windows method like Internet Connection Sharing, (ICS) then a software solution is 
usually your best option. A wide variety of software-based firewall solutions exist, but 
some are more popular than others. Windows XP includes a native firewall in the form of 
the Internet Connection Firewall (ICF). While not nearly as fully-featured as some of the 
third-party programs available, ICF handles the job of blocking requests originating from 
the Internet, allows you to selectively sanction different types of TCP/IP requests into 
your network, and gives you control over how the system will respond to common 
requests such as a ping. On the downside, ICF is fairly limited in that it doesn’t allow you 
to control which resources internal systems can access on the Internet. In cases where 
your needs are basic or cost is an issue, a solution like ICF will get the job done, and do it 
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well. ICF is configured via the Advanced tab of the properties of a connection .  
If you’re looking for more out of your software firewall than just the ability to block 
Internet users from accessing your PC or network, then you’ll need to take a closer look 
at third-party software. Two of the most popular solutions for home and small office users 
include ZoneAlarm and Norton Personal Firewall. Both programs are relatively 
inexpensive and offer you a much more granular level of control over system and 
network security. 
Firewall features 
When selecting a firewall solution, it’s well worth taking the time to examine the features 
that different hardware and software platforms support prior to making a decision. This is 
a simple affair when evaluating software, since both ZoneAlarm and Norton Personal 
Firewall allow you to download time-limited trial versions prior to purchase. Things 
aren’t as simple on the hardware solution side, since vendors will include different 
capabilities with their project and you really don’t have the option of trying before you 
buy. Rather than going through the pain of learning that a feature you want isn’t included 
in the model you’ve purchased, this is where it pays to do your homework in advance. 
Some of the features to consider when looking for a firewall solution include support for 
controlling access for internal systems, intrusion detection, MAC address filtering, URL 
blocking, custom rule creation, various content blocking features, and more. Each of 
these capabilities will be looked at in more detail in the following sections. 
Outside in 
The most important feature of any firewall is its ability to control access from the Internet 
to your PC or network. You’ll find that by default, most firewall software will be 
configured to block all requests for resources on your PC or network that originates from 
the Internet. This is good news, since hackers, crackers, and script kiddies (non-hackers 
using pre-built tools to try and hack into your system) are constantly trying to connect to 
Internet systems looking for easy targets. Their reasons for wanting to access your system 
range from curiosity (what can I find?) to malicious behaviour (let’s install a Trojan horse 
and try to take complete control of this system!), so keep your guard up. However, while 
blocking all connection attempts from outside users is a good default, there will be times 
when you want Internet-based users to be able to connect. This may be the case if you 
have an FTP server installed where you share files with work colleagues. In this instance, 
the firewall needs to be configured with a rule to allow Internet-based FTP traffic to gain 
access to your system or network. In the case of a hardware router with a built-in firewall, 
this would involve configuring a rule that permits all traffic from the Internet destined to 
TCP port 21 (the default FTP port) to be forwarded to your internal FTP server. For a 
higher degree of control, access to your FTP server could be made more limited by 
configuring your firewall to only allow external users from certain IP addresses to 

connect. When selecting a firewall, try to choose one that gives you the option to create 
more granular rules for incoming traffic. This provides a much higher degree of control 
than a firewall that doesn’t allow you to limit connections to specific hosts, and by 
extension makes your PC or network more secure. 
Inside out 
Along with the ability to keep the bad guys out of your network, you may also be looking 
for a method of controlling the traffic that leaves your network destined for the Internet. 
You may want to limit the types of services that your internal users have access to, such 
as bandwidth-consuming services like Kazaa. In many companies, firewalls are used to 
limit users to basic and common services like web (HTTP), email (SMTP and POP3), and 
so forth. Not only does this give the company greater control over the way the Internet 
connection is used, but it also ensures that users are denied access to services that might 
otherwise have an impact on their productivity. 
In the same way, perhaps you only want certain users to have Internet access. Most 
hardware and software firewall solutions will allow you to control exactly which users are 
allowed to access the Internet according to their IP address. This is a great way to stop 
certain users, while permitting others access. Regardless of your exact goals, this level of 
control is useful for everyone from parents to the administrator of even a very large 
network. 
One additional but related feature found in many software firewall packages is the ability 
to restrict access to the Internet by certain programs. For example, you can configure a 
list of exactly which programs are authorised to access an Internet connection, such as 
Internet Explorer or Outlook Express. This feature is especially useful since it can help to 
ensure that any malicious applications installed on your system (such as a Trojan horse 
program) can’t access the Internet, thus rendering them useless. This is an extremely 
useful and important feature of programs like ZoneAlarm and Norton Personal Firewall. 
If you’re evaluating either, their relative merits will be commented upon a little later in 
this feature. 
Intrusion detection 
Most home and small office firewall solutions have traditionally only provided what’s 
known as ‘stateless’ service. At the most basic level, a stateless firewall will inspect each 
packet that attempts to pass through the firewall, and then accept or reject the packet after 
considering the rules that have been defined by the firewall administrator. While this 
basic function is critical, a stateless firewall does nothing to determine whether a packet is 
valid, beyond looking at the IP address and the port numbers of the source and destination 
hosts. 
Most of the newer firewalls on the market today provide an option to enable ‘stateful’ 
service, or only use this option by default. A stateful firewall not only checks that packets 
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match the IP address and that the port rules have been defined, but it also checks to 
ensure that the contents of the packets are valid and not some attempt to maliciously use 
the connection by a hacker. A stateful firewall does this by tracking each connection, and 
then looking for abnormal or suspicious behaviour. In cases where the behaviour of the 
connection is suspicious, events can be logged or the connection itself can be terminated 
by the firewall. The methods available vary from firewall to firewall. As a general rule, 
the more complex and expensive the firewall, the more advanced the intrusion detection 
capabilities it provides. If you’re going to implement your own firewall for a home or 
small office, then a stateful model should be a key pre-requisite and is well worth 
implementing, even if it costs a tiny bit more up front. 
MAC filters 
Although IP addresses are important, every client on an Ethernet or Wi-Fi network 
ultimately identifies and communicates with other systems on the network using MAC 
addresses. Any system with a wired or wireless network card installed has a MAC 
address that’s globally unique, providing you with another method to control Internet 
access. For example, consider a situation where a user knows their IP address is blocked 
from access. If that user is running an operating system like Windows 98 or Me, they 
could easily change their IP address to another value, and perhaps one that’s allowed to 
access the Internet. If a MAC address filter were configured for this system, it wouldn’t 
be allowed to access the Internet under any circumstance, regardless of the IP address in 
use. Again, this feature gives you a more granular level of control over who should or 
shouldn’t have access, so is well worth looking for in a firewall solution. 
Virtual DMZ hosts 
Most home firewall solutions, such as hardware routers, use a technique called Network 
Address Translation (NAT) to enable multiple PCs on the private network to connect to 
the Internet using a single public address provided by an ISP. This technique is useful due 
to the scarcity of public IP addresses, and the fact that most providers won’t provide more 
than one public address without additional charges. Internal clients simultaneously ‘share’ 
the single public address, with the NAT device (in this case the hardware router) keeping 
track of the various connections. On a Windows system, Internet Connection Sharing 
(ICS) provides a basic NAT function when it’s enabled. 
Unfortunately, not all applications work well in NAT environments as they require direct 
end-to-end connectivity without an intermediary (the NAT server) translating packets. 
For this reason, one of the features that you might want to look for in a firewall solution is 
the ability to define virtual DMZ hosts. DMZ is short for demilitarised zone, a term 
traditionally used to describe a portion of a network that’s accessible to Internet systems, 
but distinct and separate from the private network. When virtual DMZ hosts are 
supported and designated, a client system can be granted unrestricted two-way access to 
the Internet via the router by bypassing the NAT function. This capability is rarely 

required by applications, but if you’re having issues getting a certain program to function, 
then it’s definitely worth having at your disposal. URL blocking 
Although support for URL blocking varies between different firewalls, it’s another 
feature that you might find useful. When URL blocking is enabled, you can configure 
lists of web sites or keywords that a user on your network won’t be able to access. As an 
example, a company might want to ensure that users don’t use a service like Hotmail as a 
method of circumventing the company mail server. In this case they would block the 
www.hotmail.com site, or any related site for that matter. Unfortunately, the 
configuration of URL blocking can be fairly time-consuming, especially in cases where 
you have sites and many keywords that you wish to block. In situations where you want 
to be able to selectively permit or block access to sites in a granular fashion (such as by 
category, topic, or keyword), a better solution is to implement content-control software 
such as NetNanny. This will offer you the option to selectively enable or disable broad 
types of content in a single mouse click. 
Cool add-ons 
As a consumer, the time couldn’t be more right to be in the market for a firewall solution 
for two reasons. Firstly, prices for both hardware and software versions have dropped 
dramatically due to heavy competition. Secondly, the fierce competition in the industry 
has forced manufacturers and developers to provide more bang for your buck in terms of 
additional features and capabilities as a way of differentiating their products. Software 
like ZoneAlarm not only provides basic firewall functions but also allows you to block 
cookies and banner ads. On the hardware front, vendors like SMC include features like 
Dynamic DNS client components to automatically update Internet DNS servers when 
your DHCP-allocated IP address changes, thus avoiding manual reconfiguration. You 
won’t need all of the cool add-ons that manufacturers and developers are providing, but 
the choice and flexibility is an added bonus when you need it. Final thoughts 
If you’re currently in the process of evaluating a firewall solution for your home or office, 
take the time to determine your needs before you buy. It may involve a little more time 
and effort on your part, but ultimately a firewall solution that meets all of your needs is 
money well spent. 
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